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A SYSTEM TO ANALYZE CONTINUOUS INK JET DROPLETS 
 

George Randolph Maruschock, MSEE 
 

University of Pittsburgh, 2004 
 
 
Ink jet technologies – also known as microdrop technologies – are receiving increased interest in 

applications outside of traditional printing and marking.  Because of this, methods and 

procedures are necessary to evaluate components and fluids of designs for non-printing 

applications.  Much attention has been spent on drop on demand (DOD) printing due to its large 

commercial availability, which has caused continuous ink jet (CIJ) printing to be neglected.  This 

issue is addressed by developing procedures to photograph droplets produced by a CIJ printer in 

the absence of charging and deflection.  Both an OEM printer and a custom experimental setup 

are used to supply fluid pressure and modulation voltage to a CIJ modulator and nozzle.  The 

resultant droplets are photographed with two different camera systems, and analyzed with 

Matlab and ImageJ.  With these programs, methods are presented to analyze the velocity, 

volume, drop production rate, and spacing of the droplets so that these factors can be evaluated 

in the design of a new system that uses CIJ technology. 
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1.0  INTRODUCTION 

1.1  BACKGROUND 

The use of inkjet technologies – also commonly known as microdrop technologies – has 

witnessed an increased level of research and applications outside of traditional printing[1].  

Personal and industrial devices that have been developed for several decades have fine-tuned the 

technology in terms of precision and cost.  Resources for the technology are widely accessible 

due to the commercial availability of the technology, and the low impact nature of the 

technology is extremely attractive for a wide variety of applications. 

For these same reasons recent research into new applications has focused on a style of 

inkjet technology referred to as drop on demand (DOD), the standard printing style found in 

personal printers.  Continuous ink jet (CIJ) printing is a printing technology that is not as widely 

commercially available as DOD printing, and has been neglected because of such reduced 

accessibility.  Nonetheless, CIJ printing has many distinct advantageous over DOD printing, and 

is worthy of investigation.  Specifically, this thesis investigates the technologies of fluid 

modulation and ejection in the CIJ. 

1.2  PROBLEM STATEMENT 

The purpose of this thesis is to develop a system consisting of hardware, software and 

procedures that will allow a CIJ designer to analyze the ink drops created by the CIJ technology.  

This system will allow the designer to manipulate controllable factors such as system pressure, 

modulation voltage, and modulation frequency.  Characteristics such as ink drop volume, 

spacing, drop production rate, and velocity, which are factors in the quality of the CIJ system, are 
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to be observed and evaluated by the system.  Such a system with these capabilities will be highly 

desirable to CIJ design because it will eliminate trial and error methods of testing and evaluation 

and allow precise measurement of system characteristics. 

1.3  APPROACH TO THE PROBLEM 

Both an OEM CIJ printer and a custom printing apparatus that could control the 

modulation voltage, modulation frequency, and fluid pressure were used in the analysis.  For the 

custom test unit, the OEM CIJ printer was used to reproduce the modulation circuitry and a fluid 

pump of similar specifications to what is used on the OEM printer to supply water to a fluid 

ejection system of similar design to an OEM print head associated with the OEM printer.  This 

system allowed the system pressure, modulation voltage, and modulation frequency to be 

adjusted.  In each experimental setup, the same fluid ejection system was used. 

Resultant fluid drops were captured with two types of imaging systems.  The first 

consisted of a Nikon digital camera coupled to a microscope.  This system was used solely for 

imaging ink drops produced by the OEM printer.  The second consisted of a Sensicam high-

speed camera with a microscopic lens, used in conjunction with the custom system. 

To analyze the captured drops for volume, spacing, and velocity the photographs were 

processed with the image analysis software ImageJ, and the mathematical software package 

Matlab, and associated numerical methods were developed to measure the desired variables.  

Results from each method were compared to evaluate their accuracy and consistency. 
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2.0  CONTINUOUS INK JET OPERATION 

2.1  BASIC PRINCIPLES 

CIJ printing is a method of marking where an ink stream is continuously run under 

pressure, and a sinusoidal agitation of the fluid allows the fluid to break up into a train of 

droplets. Although fluid streams will naturally break up to some extent at a given distance, this 

sinusoidal agitation forces the stream to break up closer to the nozzle exit, controllably, and 

consistently.  A piezo crystal in contact with the fluid is typically used to provide this sinusoidal 

agitation.  As the stream breaks into droplets, these droplets pass through what is called a charge 

tunnel made of conductive material and connected to a quanitzer.  Each droplet is given an 

individual charge as it passes through the charge tunnel.  Once through the charge tunnel the 

droplets enter a constant electrostatic field and deflect from their flight path at an angle 

proportional to how much charge was induced upon them in the charge tunnel.  This electrostatic 

field is produced by what are called deflection plates that are connected to a high voltage DC 

power source.  Droplets not to be deflected are given a negligible charge and therefore 

experience negligible deflection.  A return system collects the droplets that are not directed to the 

substrate so as to reuse the ink.  CIJ printing can thus be divided into four essential features that 

define its operation: modulation, charging, deflection, and collection. 

Applications of CIJ printing include product labeling in the food and beverage industry, 

bar coding, and various other product marking situations.  Because of this variety of media 

possible substrates include - but are not limited to - paper, plastic, glass, metal, and wood.  The 

object to be marked is physically moved perpendicular to the direction of deflection. 

An illustration of the concept of CIJ printing and the components essential to its 

operation is given in Figure 1.  In this illustration, droplets of different magnitudes of deflection 

are given different shades of grey to emphasize this characteristic.  The process has no effect on 

the color of the droplets, which is only dependent on the ink used.  An original Linx MIDI CIJ 
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print head is show in Figure 2, and an example of it in operation is shown in Figure 3.  It can be 

seen that as the print head is moving horizontally from left to right, the print head deflects the ink 

vertically to create text. 

 

 

 

Figure 1: Illustration of Continuous Ink Jet Printing 
 

 

 

Figure 2: Original Linx Print Head 
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Figure 3: Print Head in Operation 
 

 

2.2  FLUID EJECTION SYSTEM 

The focus of this thesis is the droplets produced by the CIJ system in the absence of 

charging, deflection, and collection.  Components responsible for modulating the fluid stream 

and releasing the fluid into the atmosphere will henceforth be referred to as the fluid ejection 

system.   
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The main components of the fluid ejection system are the modulator and nozzle.  While 

the modulator was of identical design to that found in the Linx MIDI CIJ print head (shown in 

Figure 2), the nozzle was modified.  Although the nozzle’s physical characteristics are different 

than that of the original, its functionality has not been disturbed.  A printed circuit board (PCB) 

based on the Linx MIDI CIJ print head was used to hold the nozzle and modulator in place.  

Excess material was removed from the PCB so that the minimum amount of material necessary 

to hold the components remained. 

Fluid was supplied to the modulator feed line with 0.0625-inch inner diameter, 0.125-

inch outer diameter Teflon tubing.  A return line also exists to control the pressure or flush the 

system.  These lines are interchangeable.  Modulation of the fluid was actuated by a bimorph 

piezo crystal (Morgan Matroc, 62155) that was in contact with the fluid.  Voltage was supplied 

to the piezo crystal with a RG174/U 50 Ohm coaxial cable.  The inner conductor of the coaxial 

cable was connected to a 24-gauge wire, which supplied the signal to the piezo crystal with a flat 

brass ring.  The outer conductor connected the modulator body to ground, which effectively 

connected the fluid in the modulator to ground as well.  A Teflon seal allows the piezo crystal to 

contact the fluid without fluid leaking out of the system.  As an extra measure of protection GE 

TSE397-C silicone rubber was applied to the modulation wire entrance to protect the wire 

insulation and components inside the modulator body from caustic materials. 

The modulator was coupled to the nozzle on the printed circuit board, and proper fluid 

sealing was accomplished with an o-ring.  For the fluid exit, an orifice with a 60-micron diameter 

(Swiss Jewel, P/N A2.00) was used.  Both the modulator and nozzle were designed and produced 

by Mr. Scott McPherson of the Swanson Center for Product Innovation.  The PCB was designed 

with Cadence’s PCB Design Studio, and manufactured at Advanced Circuits.  A detailed 

mechanical drawing of the modulator and nozzle is presented in Figure 4, and the assembled 

system can be viewed in Figure 5. 
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Figure 4: Fluid Ejection System Detailed Drawing 
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Figure 5: Assembled Fluid Ejection System 
 

 

Fluid enters the feed line of the modulator at a typical pressure of 40 PSI (based on the 

Linx 6200 Printing System).  The return line is either closed or restricted enough so that 

sufficient pressure exists at the orifice to allow fluid through it.  If the return line is not restricted 

enough, there will not be enough pressure for fluid to exit through the orifice. 

As fluid is continuously supplied, the piezo crystal is actuated by a sinusoid.  Nominal 

values of this signal are 120-volts peak-to-peak at a frequency of 80 kHz (based on the Linx 

6200 Printing System).  This sinusoidal vibration is translated as a disturbance into the fluid in 

the modulator and effectively propagates along the fluid as it travels through the nozzle.  When 

the fluid exits the nozzle, it is initially a solid stream, but the sinusoidal modulating wave 

imposed in the stream causes it to break up into individual droplets, as can be seen in Figure 6.  

In this picture, the stream is traveling from right to left. 
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Figure 6: Example of Breakup Characteristic 
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3.0  EXPERIMENTAL SETUP AND PROCEDURE 

Two different experimental systems were created and used to generate photographs of 

droplets.  For each system, the fluid ejection system described in section 2.2 was used. 

The first system consisted of a Linx 6200 printing system to supply modulation signals 

and fluid pressure to the fluid ejection system, and a Nikon CoolPix 995 digital camera fitted to 

an Edmund Scientific microscope with a 2X adapter was used to photograph the ink drops.  All 

adjustability of the system variables was performed with the Linx 6200 printer. 

The second system consisted of modulation circuitry based on the Linx 6200 printer, and 

a fluid pump of the same specifications as that found in the Linx 6200 printer, which allowed 

direct control of all system variables.  A Sensicam high-speed camera was used to capture the 

resultant drops.  

3.1  LINX PRINTER WITH NIKON CAMERA 

The following text under subsection 3.1 describes; the experimental set up used to create 

ink droplets with the Linx 6200 Series CIJ printer, and the steps used to photograph them with 

the Nikon CoolPix 995 digital camera.  Clear and concise descriptions of commands used on the 

Linx printer and the Nikon camera are given, but no attempt has been made to recreate the level 

of detail and reach covered by their respective manuals.  For additional information or 

clarification of commands or items mentioned the reader of this document should refer to the 

printer[2] and camera[3] manuals. 
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3.1.1  Experimental Setup 

To illuminate the ink stream, a PCB designed after the Linx MIDI CIJ print head (shown 

in Figure 2) was modified to hold an LED securely.  This PCB had all material from the edge of 

the LED to where the nozzle is mounted removed.  A charge tunnel was mounted into the PCB 

in order to hold the LED.  Since it protruded above the LED, material from the charge tunnel on 

the topside of the board was removed to allow the most light possible from the LED to be in the 

field of view and to allow the camera to focus on the ink drops and not the charge tunnel.  A 

yellow LED (Fairchild Semiconductor, Part Number MR3350) was then put into the charge 

tunnel, and connected to a DB-15 connector for use with the Linx 6200 printing system.  Yellow 

was chosen because of its high contrast to the blue ink used by the system.  Additionally, GE 

TSE397-C silicone rubber insulation was applied to the LED to protect it from caustic materials 

and to avoid any possibility of short-circuiting the anode and cathode of the LED. 

The printed circuit board that provided a light source and the fluid ejection system were 

fitted to a block of Plexiglas.  The light source and fluid ejection system were mounted in such a 

manner that the angle of ink ejection would be perpendicular to the angle of light projected from 

the LED.  This can be seen in Figure 7. 
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Figure 7: Fluid Ejection System and Lighting Held by Plexiglas 
 

 

Photography to record the ink drops was achieved with a Nikon CoolPix 995 digital 

camera coupled to an Edmund Scientific microscope.  Additional magnification was 

accomplished by using a 2X adapter as the coupler.   
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A circuit board holder (PanaVise model 315) supported by a standard base (PanaVise 

model 300) and a weighted base mount (PanaVise model 308) were used to hold the Plexiglas 

fixture into place.  Orthogonality of the viewing surface to the microscope was achieved by using 

a level to adjust the PCB. The lens of the microscope was adjusted to be a safe distance from the 

nozzle so that the risk of getting ink on the lens would be minimized.  This general concept is 

conveyed where the microscope, vise, level, and the devise used to hold the LED and nozzle can 

be seen in Figure 8. 

 

 

 

Figure 8: Adjusting PCB Holder 
 

 

The nozzle, modulator, and LED were then connected to the Linx 6200 printing system, 

which supplied the modulation voltage, LED voltage, and fluid pressure.  The system pulsed the 

LED synchronously with the modulation signal to make the drops appear to freeze in flight due 

to the stroboscopic effect.  Blue MEK based ink was used as the fluid.  Figure 9 displays the 

overall test environment. 
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Figure 9: Linx Overall Test Environment 
 

 

3.1.2  System Control and Adjusting Input Variables 

3.1.2.1  Starting the Printer  In order to start the fluid stream the “Quick Start Jet” feature was 

used.  After initiation, the pump system went through several cycles before the stream appeared.  

To stop the fluid stream the “Stop Jet” feature was used.  The system again went through several 

cycles as it purged the modulator before the jet was completely turned off.  Table 1 illustrates the 

keystrokes and menu selections from the main menu needed to start and stop the jet.  Keys or 

menu options are in bold, instructions are in italic.  All control was performed with the 

QWERTY style keyboard on the printer. 
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Table 1: Starting and Stopping the Jet of the Linx 6200 Printer 

Parameter Steps 

Start Jet F4: Setup → Diagnostics → Quick Start Jet 

Stop Jet F4: Setup → Diagnostics → Stop Jet 

 

 

3.1.2.2  Disabling Feedback Control  It was found to be desirable to disable any system control 

variables that were not in use.  Doing this allowed the use of the jet without the system 

automatically shutting down due to erroneous feedback that the printing system may have 

detected.  Disabling feedback correction also maintained a steady stream since the system would 

not try to compensate for feedback variables that were not present.  TABLE 2 illustrates the 

keystrokes and menu selections from the main menu needed to disable such parameters. Keys or 

menu options are in bold, instructions are in italic. 

 

 

Table 2: Disabling Feedback Parameters of the Linx 6200 Printer 

Parameter Steps 

Disable Phase Fault 
F4: Setup → Diagnostics → Phase Fault → Enter → Toggle left or 

right till OFF is seen → Enter 

Disable TOF 

Correction 

F4: Setup → Diagnostics → TOF Correction → Enter → Toggle 

left or right till OFF is seen → Enter 
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3.1.2.3  Adjusting Pressure and Voltage  The Linx 6200 printer allowed control of the pressure 

supplied to the fluid ejection system and the voltage magnitude supplied to the piezo crystal.  

Modulation frequency was not adjustable.  Table 3 illustrates the keystrokes and menu selections 

from the main menu needed to adjust these variables.  Keys or menu options are in bold, 

instructions are in italic. 

 

 

Table 3: Pressure and Voltage Control for the Linx 6200 Printer 

Parameter Steps 

Pressure 
F4: Setup → Diagnostics → Set Pressure → Enter → enter a value 

from 0 to 255 → Enter 

Modulation Voltage 
F4: Setup → Hardware Setup → Reference Modulation → Enter 

→ enter a numerical value for voltage → Enter 

 

 

While the entry for voltage represents the actual peak-to-peak voltage applied to the 

piezo crystal, the entry for pressure represents the decimal equivalent of an 8-bit code for the 

pressure.  The pressure in PSI can be calculated by dividing the decimal value entered into the 

Linx 6200 printer by 3.9.  This corresponds to a pressure range of 0 to 65.4 PSI. 

Pressure PSI( )= Decimal Entry
3.9
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3.1.2.4  Clearing Blockage  In the event of the nozzle being blocked by foreign matter, the Linx 

6200 printer has a “Clear Nozzle” feature.  Access was obtained by using the following 

keystrokes: F4: Setup → Diagnostics → Clear Nozzle → Enter → Enter a number → Enter.  

After hitting “Enter,” the nozzle was held with a rag and drops of MEK were slowly placed on 

the orifice.  Solvent was then drawn into the system in an effort to clear any foreign matter from 

the orifice.  The number entered represented how many “Clear Nozzle” cycles were performed.  

Three cycles are what is suggested by the printer manual.  If this procedure did not work, the 

nozzle was carefully disassembled, submerged in MEK for an extensive period then 

reassembled. 

3.1.3  Acquiring Photographs 

3.1.3.1  Adjusting Field of View  Held by the vise, the Plexiglas apparatus was placed under the 

lens of the microscope.  Since the LED is the source of light, it was brought into the field of view 

first by looking directly into the microscope to place it in the field of view of the microscope.  

Then, after attaching the camera to the microscope the LED was brought into the field of view of 

both the microscope and the camera by looking at the LED through the camera and adjusting the 

zoom settings of the camera, the settings of the microscope, and the LED position until it was 

visible.  A thin wire or a pair of tweezers was used to probe the edges of the LED to make sure 

the entire LED was in the field of view.  Doing so was essential for a reference scale.  If it was 

not entirely in the field of view, the focal adjustment and the distance from the LED to the 

microscope lens were adjusted so that it was. 
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3.1.3.2  Focusing on the Ink Drops  Once the LED was in the field of view, the ink stream was 

initiated as described in section 3.1.2.1.  Caution was taken not to get ink on the microscope lens 

by covering it with paper while the jet was starting.  After the jet was on, the focus was adjusted.  

The camera has automatic and manual focus settings.  Automatic focus is the default setting for 

the camera, though manual focus was preferred.  The camera was manually focused by turning 

the “Mode Dial” to “M” and holding down the button labeled “M-Focus” while turning the 

“Command Dial” until the ink drops were in focus.  The optimum focal length was found to be 

31 mm. 

3.1.3.3  General Camera Settings  Analysis of the ink drops was based on the distinction of the 

ink drops from the background.  Color was therefore of no concern, and played no role in the 

analysis, and the camera saturation was set to black and white to give clearer images of higher 

quality.  Pressing “Menu” on the camera while the “Mode Dial” was set to “M” turned on the 

shooting menu, where the “SATURATION” option was adjusted to “B&W” in the first shooting 

menu. 

Images of the highest quality and size were desired so these options were set to their 

maximum.  This was done by pressing the “Qual” button until “Hi” was visible, and turning the 

“Command Dial” while holding down the “Qual” button until no size indication was visible, 

indicating the largest picture size. 

The camera was also adjusted for the use of the 2X adapter by pressing “Menu” with the 

“Mode Dial” set to “M” and selecting the “Telephoto 1” option for “LENS” in the first menu. 

3.1.3.4  Shutter Speed and Aperture  The best results were achieved by adjusting the shutter 

speed manually while the camera automatically adjusted the aperture.  With the “Mode Dial” set 

to “M,” this feature was selected by pressing the “Mode” button and turning the command dial 

until mode “S” was selected.  The shutter speed was then selected by turning the “Command 

Dial” until the desired shutter speed was obtained. 
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Photographs were taken with shutter speeds from 1/4 of a second to 1/1000 of a second.  

Any speed slower than 1/4 of a second became overexposed and anything faster than 1/1000 of a 

second was severely under-exposed. 

With the camera adjusted to the desired settings, the “Shutter Release Button” was 

depressed to take photographs.  Once all desired photographs were taken, the jet was stopped as 

described in section 3.1.2.1, and the photographs were downloaded from the camera for analysis. 

3.2  CUSTOM SYSTEM WITH SENSICAM CAMERA 

The following text under subsection 3.2 describes; the experimental set up used to create 

fluid droplets with the custom system, and the steps used to photograph them with the Sensicam 

High-speed camera.  Clear and concise descriptions of commands used to control the camera are 

given, but no attempt has been made to recreate the level of detail and reach covered by the 

manual for it and its software.  For additional information or clarification of commands or items 

mentioned the reader of this document should refer to the manuals for the camera[4] and its 

software[5]. 

This system was created because, while the Linx 6200 system was adequate for the basic 

requirements of producing and photographing ink droplets, it did not allow the control of 

modulation frequency.  In addition, the system was cumbersome in its operation.  The amount of 

feedback control often hampered experiments, and the cycles that the pump system went through 

when starting and stopping the ink stream made experiments very time consuming. 
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Fluids could not be readily changed in the Linx 6200 printer.  Purging the system of all 

existing fluids and clearing all fluid handling components to avoid contaminating the new fluid 

would be required to try new fluids.  The Linx 6200 printer was designed to print MEK based 

ink, and using new fluids would have risked damaging the system. 

Lastly, photographing the droplets with the Nikon camera and microscope was 

considered insufficient.  The limited field of view of the microscope and the small area 

illuminated by the LED proved very limiting in how much of the stream could be photographed.  

Individual droplets could not be captured, or a sequence of pictures that can be viewed as video 

could not be created with the Nikon camera’s shutter speed.  The stroboscopic effect and long 

shutter speed created images that consisted of multiple instances of time superimposed upon 

each other. 

Because of all these factors, the custom system was developed to address and solve these 

issues. 

3.2.1  Experimental Setup 

The experimental set up using the Sensicam Camera to photograph fluid droplets created 

by the custom test apparatus consisted of five main components: a fluid pump to deliver liquid to 

the fluid ejection system, an amplifier to deliver a sinusoidal signal to the modulator, a lighting 

source, the camera, and a mounting system. 

3.2.1.1  Fluid Pump  A series 120 Electromagnetic Drive Pump manufactured by Micropump, 

Inc., was used to supply fluid to the fluid ejection system.  This pump was selected because it 

matched the requirement to be able to create a fluid pressure of at least 40 PSI, which was the 

nominal pressure produced by the Linx 6200 Printing System. 

For a fluid reservoir, a 125 mL Nalgene bottle was used.  Holes were drilled and brass 

unions (Swagelok, part number B-200-6) were fitted to the lid of the bottle, which allowed 

tubing to be fitted to the bottle securely.  Externally, tubing of equal lengths (approximately 3 

inches) was connected to the unions.  Internally, one union was fitted with a piece of tubing that 

extended to the bottom of the reservoir, while the other was fitted with a piece of tubing 
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approximately one half inch long.  This was done with the intention of having feed and return 

lines for the reservoir to be used in conjunction with the feed and return lines of the fluid ejection 

system.  Quick release couplings (Colder Products, SMC series) were also used to allow quick 

removal of the reservoir without loosening the brass unions.  The tubing used was 0.0625-inch 

inner diameter, 0.125-inch outer diameter Teflon tubing.  Figure 10 illustrates the reservoir. 

 

 

 

Figure 10: Fluid Reservoir 
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This reservoir was directly connected to the intake of the pump.  The output of the pump 

was then fitted to a pressure gauge capable of reading up to 60 PSI (manufactured by Continental 

Precision Instruments).  From the pressure gauge, tubing was connected to a filter, and then to 

one opening of the ink ejection system.  Originally, it was attempted to run a return line from the 

nozzle back to the reservoir, but this did not create enough pressure to allow fluid through the 

orifice.  To solve this, the return line of the ink ejection system was fitted with tubing, and this 

tubing was closed with vise grips so that all in coming fluid could only exit through the orifice.  

Distilled water was used as the liquid.  For the path from the reservoir to the pump and then to 

the nozzle two different tubing diameters were used, and were connected with couplings. 

A regulated variable DC power supply (Extech, model 382203) was directly connected to 

the pump in order to supply voltage to activate it, and vary the pressure.  A schematic 

representation of the fluid connectivity is displayed in Figure 11.  All components are 

represented, and except for connection lines inside hashed boxes, thin lines are used for 

sixteenth-inch inner diameter tubing, and thicker lines are used for eighth-inch inner diameter 

tubing.  A photograph of the fluid pump, reservoir connection, and pressure gauge is seen in 

Figure 12. 

 22



 

 

 

Figure 11: Fluid Connectivity 
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Figure 12: Fluid Pump 
 

 

3.2.1.2  Modulation Amplifier  A modulation amplifier was built based on schematics of the 

Linx 6200 printing system by Mr. Joshua Maina.  This amplifier used a sinusoidal signal as an 

input, and created an amplified signal in phase with the input.  For the input a function generator 

(Hewlett Packard 33120A) was connected directly to the input of the modulation amplifier.  The 

output of the amplifier was first measured on an oscilloscope (Hewlett Packard 54602B) to 

verify the proper signal was being generated, and then connected to the RG174/U coaxial cable 

of the ink ejection system.  Figure 13 gives a schematic of the circuit.  The input is to the far left, 

and the output of the circuit is to the far right. 
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Figure 13: Modulation Circuitry 
 

 

3.2.1.3  Light Source  Attempts at using incandescent and fluorescent light sources were made, 

but these types of light sources proved to be inconsistent over their lifetime and difficult to work 

with due to their bulkiness and heat generation.  In particular, disruption of the filament had 

noticeable effects on the quality of the incandescent light sources, and the fact that the lights 

were several times the size of the fluid ejection system made it difficult to illuminate the area 

millimeters away from the nozzle.  LED light sources were then tried and proved to be much 

more useful due to their greater stability, the absence of heating characteristics found in 

incandescent sources, and their more manageable size.  Efforts were made with both pre-

manufactured LED arrays and individual LEDs.  In each case a variable DC power supply 

(Hewlett Packard E3631A) was used to supply voltage to the LEDs, and held in place by a hobby 

vise (Wilton 63500/3VB Holding Devise). 

Yellow and red prefabricated LED clusters produced by Sunbrite LEDs (part numbers 

SSP-LXC1283S24 and SSP-LXC128624, respectively) were initially tried.  Each cluster 

consisted of thirty two 0.5 mm LEDs in a circular array.  While the individual LEDs produced 

enough light for the camera, the emitted light of each LED did not have a wide enough angle to 
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overlap each other and create the appearance of one solid light source.  In addition, the spacing 

in between each LED was large enough to create too much non-illuminated area to be useful.  

Attempts at moving the light source farther away from the camera were made to give the light a 

greater chance to spread by the time it reached the lens, but the light intensity was not great 

enough when this was done. 

Greater success was achieved with white LEDs, also produced by Sunbrite LEDs (part 

number SSP-01TWB9WB12).  These LEDs were 10 mm in diameter, rated at 12-volts, and had 

an intensity of 11000 millicandela, which was the highest possible intensity found at minimum 

cost.  Though designed for automotive applications they were easily adapted to the application of 

lighting the droplets of water.  Their leads for the anode and cathode were easily accessible, and 

their wedge base designed for a specific mounting system proved very useful for holding the 

LEDs securely in the hobby vise.  Four of these LEDs were connected in parallel, and held in a 

linear fashion with the hobby vise.  At the cameras highest level of magnification, one LED 

would illuminate the field of view while lower levels of magnification would require more LEDs 

to illuminate the field of view.  When close to the lens, the problem with seeing darkness 

between the LEDs was again present, but the amount of non-illuminated area was small enough 

to make the LEDs more useful than the prefabricated arrays.  Moving the light source farther 

away from the camera so that the light would disperse was more effective with these LEDs than 

the prefabricated arrays.  At farther distances from the lens enough intensity to illuminate the 

drops was produced while eliminating the darkness in between the LEDs.  Figure 14 displays a 

front and side view of the LEDs held by the hobby vise. 
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Figure 14: Light Source, Front and Side Views 
 

 

3.2.1.4  Camera System  The camera system consisted of the Sensicam SVGA high-speed 

camera, a microscopic lens by Infinity Photo Optical Company, and a Dell Pentium based PC. 

Exposure time was the main reason for choosing the Sensicam camera.  Since the piezo 

crystal was activated at a rate of 80 kHz, the assumption has been made that there is a one-to-one 

correlation between frequency and the drop production rate.  This may or may not be entirely 

true though because the system is pressurized within the modulation reservoir.  Whether the 

effects of this pressure decrease or increase the rate of drop production has been greatly 

speculated.  It was therefore necessary to take a conservative approach when selecting a camera 

and assume the drop rate was higher than 80 kHz.  Not doing so could have risked purchasing an 

imaging system that was incapable of accurately photographing the creation of drops and given 

poor results.  Using Nyquist’s theorem that the sampling frequency must be greater than or equal 
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to twice the frequency of what is being sampled ( fsample ≥ 2 fprocess) the speed requirement of the 

camera was determined.  Rounding up to 100 kHz (to be conservative) created the requirement 

that the sampling rate be greater than or equal to 200 kFPS (frames per second).  This translated 

to a shutter speed less than or equal to 5 µs.  The Sensicam SVGA high-speed camera (produced 

by the Cooke Corporation) met this with a minimum exposure time of 100 ns. 

Resolution was also an important factor.  It was desired to have the greatest resolution 

possible to be able to capture as much of the drop breakup process as possible.  The Sensicam 

SVGA had a resolution of 1280 x 1024 pixels.  A higher resolution model did exist, but was not 

affordable with the budget that existed for this and related projects. 

With an estimated drop size of no more than 200 microns, it was necessary to use a 

microscopic lens to see the droplets in detail.  An InFocus Model KC Video Microscope system 

manufactured by Infinity Photo Optical Company was used to accomplish this.  The system 

comprised of the main body lens, and four add on lenses – called objectives – to increase the 

magnification.  This system was chosen for its magnification capabilities and simplicity.  By 

directly attaching it to the camera, it was self supporting, did not require any additional 

mounting, and the different objectives were very easily changed. 

The camera was controlled by a software package called CamWare (produced by the 

Cooke Corporation), which was installed on a Dell Dimension L733R Pentium based PC.  A PCI 

board that was included with the camera was installed and provided the means necessary to 

directly connect the camera to the computer. 

3.2.1.5  Mounting System  A mounting system composed of Plexiglas and various vises was 

used to hold the camera, fluid ejection system, and lighting source in place, and was assembled 

by Mr. Stephen P. Heston.  This mounting system with the computer was placed on a six-foot by 

three-foot table.  A two inch thick sheet of Plexiglas measuring two-feet by 33.75 inches served 

as the base of the mounting system.  Stability and control of the camera were achieved by a 

precision slide (Velmex, A1512K1-S1.5) mounted to a one-inch thick piece of Plexiglas, and 

secured to the Plexiglas base.  The fluid ejection system was supported in a similar way to that of 

section 3.1.1 with the circuit board holder (PanaVise model 315) supported by a standard base 

(PanaVise model 300).  Instead of a weighted base, the standard base was mounted to a half-inch 
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thick piece of Plexiglas and supported by a four-inch drill press vise (Columbian, model 69997).  

This allowed greater control over adjustment of the nozzle perpendicular to the line of sight of 

the camera so that various segments of the stream could be brought into view of the camera.  The 

PCB that couples the modulator to the nozzle was held directly by the PanaVise circuit board 

holder.  To give greater support for the PanaVise when its center of weight was not over the drill 

press vise, a 1.189-inch thick piece of Plexiglas was used.  Free adjustment of the light source 

was achieved by allowing the hobby vise supporting the LEDs to move without restraint about 

the mounting system.  Remaining components such as the computer and power supply were 

placed outside of the main Plexiglas base on the table.  The fluid pump and modulation 

electronics were mounted on a separate utility cart.  A detailed picture of the mounting for the 

camera and fluid ejection system is seen in Figure 15.  In the middle of the photograph, the 

camera is aimed downward, while the nozzle held by the vise is positioned so the fluid stream 

will flow from right to left in the picture.  The utility cart supporting the fluid pump and 

modulation circuitry can be seen in Figure 16.  During operation the function generator driving 

the modulation circuitry was mounted on top of this utility cart. 

 

 

 

Figure 15: Overal Custom Setup 
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Figure 16: Fluid Pump and Modulation Mounting 
 

 

3.2.2  System Control and Adjusting Input Variables 

3.2.2.1  Pressure  Pressure was adjusted by changing the voltage of the power supply that 

controlled the pump.  Care was taken to adjust the voltage slowly while watching the pressure 

gauge so not to exceed the limits of the gauge.  Voltage to the nearest half-volt was measured for 

various values of pressure, and the results are displayed in Table 4. 
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Table 4: Pressure and Corresponding Voltage 

Pressure (PSI) Voltage (Volts) 

5 3.0 

10 4.0 

20 5.5 

30 7.0 

40 9.0 

50 10.5 

60 11.0 

 

 

Limited accuracy existed in the pressure gauge.  Due to instabilities in the system, the 

dial of the pressure gauge fluttered rapidly as the pressure was increased.  Therefore, the pressure 

could only be estimated to the nearest PSI.  Voltage was read directly from the gauge native to 

the power supply, which only had half-vote precision. 

3.2.2.2  Modulation Voltage  The modulation voltage was controlled by adjusting the input to the 

modulation amplifier with the function generator.  Frequency is preserved from the input to the 

output, and the voltage is amplified approximately thirty to thirty-five times the original input 

voltage.  Specific inputs necessary for outputs ranging from 50-volts peak-to-peak to 160-volts 

peak-to-peak are shown in Table 5.  Voltages in excess of 160-volts peak-to-peak exceeded the 

capabilities of the modulation amplifier, causing the output to start clipping. 
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Table 5: Input/Output for Modulation Amplifier 

Input (VPP) Output (VPP)

1.46 50 

1.78 60 

2.10 70 

2.41 80 

2.70 90 

3.02 100 

3.36 110 

3.89 120 

4.33 130 

4.70 140 

5.08 150 

5.50 160 

 

 

3.2.2.3  Lighting  To line up the LEDs within the field of view of the camera, the vise and LEDs 

were placed as close to the to the camera possible without touching the lens of the camera.  With 

the LEDs on (12 volts) and the camera in “live preview”, the height and angles of the LEDs were 

adjusted while monitoring their effect on the camera’s view.  If not high enough, shims were 

placed under the hobby vise.  Once the desired height was obtained, the apparatus was carefully 

moved backward into the focal range so that each LED and the direction that the light was being 

projected could be seen.  Positioning of each LED was confirmed by placing a thin object – such 
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as the tip of a pair of tweezers – in front of each LED and observing the output on the computer.  

The vise head was then adjusted so that the maximum light from the LED was entering the 

camera.  The light was further optimized by adjusting each LED within the vise head to be 

shining directly into the camera and to be as close together as possible to minimize dark space 

between the LEDs. 

3.2.3  Acquiring Photographs 

The following subsections describe the best procedure found to photograph the droplets.  

Except for when recording images, the CamWare was in “Live Preview” mode so that the 

subject could be visible. 

3.2.3.1  Adjust Light and Focus on Nozzle  The desired objective lens was mounted for the level 

of magnification desired (IF1 having minimum magnification, IF4 having the maximum).  As 

described in section 3.2.2.3, the light source was adjusted and positioned farther from the lens 

than the focal point.  Once this was done, the nozzle was positioned in view of the camera so that 

the direction of the fluid stream would be perpendicular to the view of the camera.  General focal 

adjustment was made by using the slide to move the camera closer to or farther from the nozzle.  

Fine focal adjustment was made with the “focusing ring” on the microscopic lens.  The minimum 

and maximum focal distance achieved by adjusting the “focusing ring” for each objective is 

listed in Table 6. 
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Table 6: Focal Range for Each Objective Lens 

Focal Range (mm) 
Objective 

Minimum Maximum 

IF1 241.3 802.6 

IF2 196.5 624.8 

IF3 159.9 291.3 

IF4 62.1 80.3 

 

 

Left-to-right (horizontal) adjustment of the nozzle in the field of view was accomplished 

by moving the PanaVise in the drill press vice.  Up-and-down (vertical) adjustment was 

accomplished by moving the fluid ejection system in the jaws of the circuit board holders.  Any 

angular adjustment was made by adjusting the means by which the circuit board holder was held 

by the PanaVise base.  Care was taken to adjust the nozzle so that it was perpendicular with the 

view of the camera.  Once the nozzle was in view of the camera, the fluid stream was initiated. 

3.2.3.2  Start Liquid Stream and Adjust Viewed Section  After getting the nozzle in view of the 

camera and the proper connections from the pump and modulation electronics to the fluid 

ejection system were completed, the fluid stream was initiated.  This was done by adjusting the 

voltage supplied to the pump to produce the desired pressure, and by setting the modulation 

voltage to the desired values and connecting the modulation amplifier to the RG174/U coaxial 

cable.  The stream was directed into an empty container so as to control the fluid. 

The fluid stream and evidence of breakup characteristics were confirmed to be active by 

direct observation and by viewing the stream through the camera.  If the nozzle appeared to be 

clogged, the same procedures to clear any blockage as in section 3.1.2.4 were followed. 

 34



Once a steady stream was produced, a photograph was taken with the nozzle in view to 

give a way to calculate a reference scale for the photographs.  The desired section of the stream 

was brought into view by carefully loosening the drill press vise and slowly moving the 

PanaVise within the drill press vise until the desired section of the stream was in view.  An 

adjustment to the position of the fluid ejection system in the circuit board holder was made if the 

stream happened to go above or below the field of view.  When the desired section of the fluid 

stream was visible to the camera, the drill press vise was tightened, and fine focal adjustments 

were made. 

3.2.3.3  Taking and Saving Photographs  Control of exposure time, delay between photographs, 

and field of view selection were executed with the camera’s software package, CamWare.  Light 

intensity was primarily adjusted by varying the voltage supplied to the LEDs, though the option 

did exist within the camera software to adjust the light level. 

The camera control window was used to adjust the exposure time and field of view of the 

camera.  Individual exposure and delay times could be adjusted for ten photographs.  For this 

thesis, delay times of zero-seconds were used.  Live preview was required to be turned off while 

adjusting the exposure time and field of view.  Since the fluid stream only occupied a small area 

in the overall viewing area, the camera control was also used to limit the photographing viewing 

area to a narrow horizontal band, though large enough to see the extents of the nozzle. 

Picture quality was observed with the black-and-white window open and live preview on.  

The live preview compensated for the exposure time and displayed what the images looked like 

with the set light intensity and exposure time, and it was thus a very useful tool in monitoring the 

intensity of the light and its effect on image quality with the desired exposure time.  Any desired 

changes to the light intensity were made at this point in time. 
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With all variables set as desired, and “Live Preview” turned off, photographs were 

recorded.  Individual photographs were taken by selecting “Acquire Picture” from the “View” 

menu.  Multiple images were taken by pressing the record button on the toolbar while the camera 

control menu was visible.  Once taken, the images could be viewed in the black-and-white 

window.  In play back mode it was necessary to adjust the options so that only the ten images 

were viewed. 

Saving individual pictures was done by selecting “Export” from the “Image” menu.  

Multiple images were saved by selecting “Export Recorder” from the “Image” menu. 
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4.0  DROPLET ANALYSIS 

Using two separate software packages, methods were developed to analyze the droplets.  

The first program used was Matlab, a commonly used program in engineering for signal 

processing, image processing, and general analysis.  The second is ImageJ, a Java based, freely 

distributed image analysis program with many of the same features as Matlab.  Though not as 

powerful and flexible as Matlab, it is presented here in the event the CIJ designer does not have 

access to Matlab, which comes at a cost. 

For the analysis, two photographs from the experimental setup using the Linx Printer and 

Nikon camera, and one set of ten photographs from the custom system and Sensicam camera are 

used in this chapter.  The first picture used here that was taken with the Nikon camera was 

recorded with a shutter speed of 1/8 second, and can be seen in Figure 17.  Figure 18 displays the 

second picture, which was taken with a shutter speed of 1/250 second.  In each photograph the 

fluid ejection system was supplied with 120 VPP modulation voltage and 40 PSI of pressure.  

The ink stream is traveling from right to left in these photographs.  The group of Sensicam 

photographs show the ink stream generated under nominal conditions, and each photograph was 

exposed for 4 µs.  An example of the Sensicam photograph can be seen in Figure 19.  Objective 

IF3 was used in these photographs, and the droplets are traveling from left to right. 
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Figure 17: Linx with Nikon Test Set Up, 1/8 Second Exposure 
 

 

 

Figure 18: Linx with Nikon Test Set Up, 1/250 Second Exposure 
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Figure 19: Sensicam Photograph, 4 Microsecond Exposure 
 

 

As was done previously in this thesis, the commands used in the software packages are 

given, but no attempt is made to give a complete description of how to operate the software.  The 

reader is advised to consult the documentation associated with the software packages for 

elaboration on information concerning any of the items discussed. 

Relevant Matlab commands are given for each subsection in this chapter.  Complete 

Matlab scripts that were used can be found in the Appendix. 

4.1  MAKING MEASUREMENTS 

For the analysis it was necessary to measure such features as the nozzle diameter, the 

stream diameters, and droplet diameters.  Because this is so common throughout all aspects of 

this chapter, this section is presented here to describe in detail the steps used to make the 

measurements. 
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4.1.1  Matlab 

With the desired figure in view, the command “pixval” was entered in the command 

window.  This created a display in the bottom left corner of the active figure window.  To 

measure a linear dimension the cursor was placed at beginning of the feature to be measured and 

the left mouse button was depressed.  Without releasing the left mouse button the cursor was 

then placed at the end of the feature to be measured.  The distance in pixels between the two 

points was read from the display in the bottom left corner and recorded.  The line drawn by this 

process is only active while the left mouse button is constantly depressed. 

4.1.2  ImageJ 

From the ImageJ toolbar the “straight line selections” tool was selected.  To measure the 

linear dimension the cursor was placed at the beginning of the feature to be measured, the left 

mouse button was depressed, and the cursor was then placed at the end of the feature, similar to 

what was done in Matlab.  Unlike Matlab, the line was still active when the left mouse button 

was released.  This allowed the “zoom” tool to enlarge the start and end points of the measured 

feature, and control the placement of the beginning and end of the measuring line as precisely as 

possible.  The measurement was then made by “Measure” from the “Analyze” menu, which 

displayed the result in a separate window.  Additionally, the counter-clockwise rotational angle 

of the line could be noted on the ImageJ toolbar when moving one end of the line. 
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4.2  PRELIMINARY PROCESSING 

4.2.1  Loading the Image 

4.2.1.1  Matlab  Images were loaded using the command “imread”. 

4.2.1.2  ImageJ  ImageJ did not require any special scripting, and files were loaded by selecting 

“Open…” from the “File” menu. 

4.2.2  Calculating Reference Scale 

In order to calculate droplet parameters in terms of useful units a reference length was 

necessary in the photographs.  For the images taken with the Nikon camera, the diameter of the 

LED (5000 µm) was used because it was the only distinctive measurable feature in these 

photographs.  The images taken with the Sensicam camera though had two features that were 

recognizable and measurable.  The first is the outside diameter of the nozzle (6350 µm), and the 

second is the diameter of the fluid stream immediately after leaving the nozzle, which was 

assumed to be the same diameter of the orifice (60 µm). These two feature measurements gave 

two reference scales, and both were used in the measurements made.  In both Matlab and 

ImageJ, the appropriate dimension was measured in terms of pixels, and this information was 

then used to convert all measurements from pixels to µm.  Since the Linx photograph taken at 

1/250 seconds does not have any observable features due to the low level of exposure, the 

reference scale from 1/8 second photograph was used.  The test setup was not disturbed in 

between these photographs, and consequently this is acceptable.  The specific steps used in each 

program are described below. 
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4.2.2.1  Matlab  The original image was brought into view using “imshow.”  The desired 

reference feature was then measured, and this measurement was then used to create the 

conversion factor for the image.  A script to load the image, display it, and turn on the interactive 

display was written, and is given in the Appendix. 

4.2.2.2  ImageJ  With the image to be analyzed in view, the reference feature was measured.  

This measurement was recorded and used to calculate the reference scale.  Automatic conversion 

was available with the “Set Scale” option found under the “Analyze” menu.  If a measurement 

was active, the length in pixels was automatically entered in the appropriate placeholder.  By 

entering the known length of the reference object, giving the units, and pressing “Ok,” all future 

measurements would be given in terms of the actual length. 

4.2.2.3  Reference Scale Values  The calculated reference scales for each photograph are listed in 

Table 7.  In this table, the calculated number of pixels found for each reference feature is given, 

and the corresponding reference scale that was calculated. 

 

 

Table 7: Calculated Reference Scale Versions 

Program Photograph Reference Feature Pixels Scale (pixels/µm) 

Linx LED (5000 µm) 701.93 0.14 

Nozzle (6350 µm) 733.426 0.12 Matlab 
Sensicam 

Stream (60 µm) 8.03 0.13 

Linx LED (5000 µm) 686.00 0.14 

Nozzle (6350 µm) 729.04 0.12 ImageJ 
Sensicam 

Stream (60 µm) 8.00 0.13 
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4.2.3  Increasing Image Clarity 

Despite the ink drops being clearly distinguishable from the background in many of the 

photographs, it was necessary to take steps to increase their definition.  This is because while the 

drops were visible overall, their edges may not have been clearly defined, making accurate 

measurements of feature sizes difficult.  Cases also existed where the droplets appeared to not 

exist at all due to poor exposure.  Processing of the images was therefore necessary to produce 

reliable results.  The same approach to improving image clarity was applied in both Matlab and 

ImageJ.  First, histogram equalization was applied.  Then, if possible, an edge detection 

algorithm was used. 

In an 8-bit grey scale image, there are 256 levels of grey intensity, ranging from solid 

black (0) to solid white (255).  In cases where the intensity levels are concentrated over a very 

small band, image definition was greatly improved by applying histogram equalization, which 

spread the intensity levels over all possible values.  Though applied to all images, this was 

especially useful in images that were underexposed due to inadequate lighting for the shutter 

speed used. 

Edge detection algorithms were available in both software packages.  These algorithms 

look for sharp changes in contrast.  What the algorithm calculates to be an edge is highlighted in 

white, and the intermediate areas are left black.  For the analysis, the actual boundary was 

interpreted to be the center of the white line drawn by the algorithm.  The Sobel method was the 

only edge detection available in ImageJ.  Thus, the same method was used in Matlab for the 

purpose of direct comparison. 

The specific commands in Matlab and ImageJ used to utilize these features are listed 

below.  Other commands specific to each program that were found to be useful in increasing 

image clarity are mentioned as well. 
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4.2.3.1  Matlab  For reference, the histogram of the image was viewed by using the command 

“imhist.”  Histogram equalization was then performed by using the command “histeq.”  In some 

cases the contrast of the equalized image would still be low, so the “imadjust” command was 

used to increase the contrast.  The effect of histogram equalization can be seen in Figure 20.  For 

the original image, it can be seen that the grey intensities are concentrated over one fifth of the 

spectrum.  After performing histogram equalization, the intensities are distributed over the entire 

range, and parts of the image that appeared to be unexposed are now visible. 

 

 

 

Figure 20: Matlab Effect of Histogram Equalization 
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The “edge” function was then used utilizing the Sobel method in order to give clearly 

defined edges.  An example of this is shown in Figure 21.  The default threshold proved to be to 

be inadequate for the processing of these images.  Table 8 displays the thresholds that were 

found to give the best result, where “graythresh” calculates a threshold level used in the detection 

based on the image used. 

 

 

 

Figure 21: Matlab Edge Detection 
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Table 8: Edge Detection Threshold Levels 

Photograph Level 

Linx, 1/8 s Shutter graythresh(<variable name>)*0.001 

Linx, 1/250 s Shutter graythresh(<variable name>)*0.36 

Sensicam graythresh(<variable name>)*0.17 

 

 

4.2.3.2  ImageJ  To view the histogram for an image “Histogram” under the “Analyze” menu 

was selected.  Two methods existed to perform histogram equalization.  One was to use 

“Enhance Contrast” from the “Process Menu.”  With this tool, the “Equalize Histogram” was 

performed.  In some cases, this option appeared to remove pixels from the edges of the droplets.  

When this occured “Adjust… Brightness/Contrast…” under the “Image” menu was selected.  

The auto button was found to adjust the spread of the intensity levels just as well.  Both methods 

were tried in order to determine which was more appropriate on a case-by-case basis.  Examples 

of the effects of histogram equalization are shown in Figure 22 and Figure 23.  In each figure, the 

top half is the photograph before histogram equalization, and the bottom half is the same image 

after equalization. 
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Figure 22: ImageJ Histogram Equalization on Nikon Photograph 
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Figure 23:  ImageJ Histogram Equalization on Sensicam Photograph 
 

 

After performing histogram equalization, the edges were automatically detected by 

selecting “Find Edges” under the “Process” menu.  In some cases, background noise would be 

high enough that this feature would not give positive results.  Results of edge detection are 

shown in Figure 24 and Figure 25.  In each figure, the top half is the photograph before 

histogram equalization and edge detection, and the bottom half is the same image after histogram 

equalization and edge detection have been applied. 
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Figure 24: ImageJ Edge Detection on Nikon Photograph 
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Figure 25: ImageJ Edge Detection on Sensicam Photograph 
 

 

Cropping the photographs from the Linx printer and Nikon Camera experiments proved 

to add some convenience.  These photographs contained a lot of unexposed area that did not 

contribute any information.  To do this one of the selection tools was used to enclose the area to 

be kept, “Crop” was selected from the “Image” menu, and the undesired portions of the image 

were removed. 
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In some cases, where a low level of noise existed in the background, the “Subtract 

Background” feature from the “Process” menu was used.  This effectively set the background to 

solid white, while maintaining the droplets in the foreground.  In cases where the background 

had too much noise and the drops were not distinguished enough from the background, this 

feature was highly counterproductive. 

4.3  VELOCITY 

A method to measure velocity was developed for the images recorded by the Sensicam 

camera since it produced multiple photographs where a droplet could be tracked over the course 

of the ten-photograph sequence.  The images recorded by the Nikon camera are still images,  and 

do not have any representation of movement.  Regardless of this, a method to estimate the 

velocity of the droplets in the Nikon photographs is presented as well. 

Despite the Sensicam photographs having extremely short exposure times, the fact that 

the droplet is in motion creates some level of blurring in the photograph as it moves during the 

exposure time.  As mentioned in Section 3.2.3.3, images for this thesis were taken with a delay 

of zero-seconds between exposures.  It is thus expected that the end position of a droplet in one 

photograph will be the same as the start position of that same droplet in the subsequent 

photograph.  This concept is related in Figure 26. 

 51



 

 

 

Figure 26: Illustration of Velocity Calculation 

 

 

From this interpretation, the distance from the right most edge of the droplet in a 

photograph to the far right edge of the droplet in next photograph corresponds to the total 

distance traveled during the time the second photograph was exposed.  If m photographs are 

used, each with an exposure time of n seconds, the velocity will be equal to measured distance, x, 

in meters over the course of the m photographs divided by (m-1)n seconds. 

 

velocity = x
m −1( )n

 

 

 52



For the Linx photographs, the velocity was estimated by assuming the drops are being 

produced at a rate of 80 kHz.  With this assumption the number of droplets in a given distance 

were measured, and used to calculate the velocity. 

 

velocity = drops
s

×
m

drops
 

 

The steps necessary to calculate the two velocities with these approaches are given 

below. 

4.3.1  Matlab 

In Matlab, one of the images from the Sensicam series was initially loaded with 

“imread.”  After turning on “pixval” in the command window, the minimum x and y coordinates 

and height and width of the area to be cropped were selected.  The goal was to remove all aspects 

of the picture except the ink stream.  These values were used to write a script that read all the 

images of the series, cropped them identically, and then assigned them to a large matrix.  This 

script can be found in the appendix.  This matrix resulted in a single picture comprised of all the 

cropped segments stacked on top of each other.  White space was added to the bottom to have an 

area to measure the distance with the method described above.  Desired processing from section 

4.2.3 was then applied to this image.  It was found that too much noise existed to perform edge 

detection, so all analysis was performed with just histogram equalization applied.  This resultant 

image can be seen in Figure 27.  The first image in the series is at the top of the figure, and the 

last image in the series is at the bottom. 
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Figure 27: Matlab Velocity Measurement 
 

 

An “insert line” tool existed in the figure window, and was used to draw lines from 

droplet to droplet for the measurements.  The drawback found was that when the zoom tools are 

used, the lines drawn do not follow the zoom, and therefore, they do not scale with the picture or 

move with the location they were initially drawn.  Using this “insert line” tool, lines were drawn 

vertically along the rightmost edge of the droplet to be followed.  When located in the next 

picture, this process was repeated until all visible occurrences of the drop were traced.  Because 

the angle of these lines was not displayed, they were estimated to be parallel to the best ability of 

the eye.  The distance of the droplet’s path over the course of photographs was measured in 

pixels by measuring the distance from the first line to the last, and converted to the appropriate 

units.  Since information on the angle of the line was not given the measurement was taken 

parallel to the stream. 
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To calculate the velocity of the droplets in the Nikon photographs, the far right edge of 

one droplet to the far right edge of a later drop was measured.  Counting the number drops along 

this distance the velocity was calculated with the equation presented at the beginning of this 

section. 

4.3.2  ImageJ 

In ImageJ, each photograph of a series or selection of photographs from the series to be 

analyzed was opened.  The height of the image area containing the stream was estimated, and 

“New…” was selected from the file menu.  A name was selected for the new image, and 

dimensions were entered.  The width was chosen to be the same as the original photographs 

(1280 pixels) and the height was chosen to be the estimated height of the area containing the 

stream multiplied by the number of photographs to be used plus 500 pixels to make sure enough 

area was available.  Following these steps generated a blank image on which to copy and paste 

segments from the series of photographs. 

Once the new image was created, the first photograph of the series was selected making 

sure the entire photograph was viewable.  Using the rectangular selection tool, the area 

containing just the stream was selected.  To ensure precise alignment with other segments the left 

and right edges of the box were positioned to the farthest extents of the image.  With the desired 

area selected, “Copy” was selected from the “Edit” menu, and inserted into the new image by 

choosing “Paste” from the “Edit” menu.  The pasted image was then dragged and dropped to top 

of the new image.  Using the arrow keys on the keyboard and viewing the ImageJ tool bar, the 

pasted image was moved to coordinates (X, Y) = (0, 0). 
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Once the first image was in place, the second image was copied and pasted in the same 

manner.  When in the new image, it was dragged and dropped directly below the first image, and 

moved using the arrow keys until the x coordinate of the image was zero.  This process was 

continuously repeated until selections from all images in the series were included in the new 

image. 

After performing any desired processing as described in section 4.3 and setting the 

reference scale for the picture, a drop was selected to follow through the sequence.  Using the 

straight-line selection tool a line was drawn from the right most edge of the droplet to the bottom 

most section of the overall image.  Consistency and accuracy were maintained by viewing the 

ImageJ tool bar to make sure the angle of the line was 270 degrees.  “Draw” was selected from 

the “Edit” menu once it was determined a straight line was successfully drawn against the right 

most edge of the droplet.  The position of the droplet being investigated in the next photograph 

was determined, and a line was drawn against its right most edge to the bottom of the image in 

the same manner.  After repeating the procedure for each photograph, the horizontal distance was 

then measured from left most line drawn to the right most line drawn. 

It was also necessary to account for any angle in the stream.  By using the straight line 

selection tool to trace the path of the stream, the counter clock wise angle around the axis was 

read from the ImageJ tool bar.  Subtracting this angle from 360 degrees gave the clockwise angle 

and was used to calculate the actual distance by dividing the measured distance by the cosine of 

this angle. 

 

actual distance =  measured distance
cos clock wise angle( )

 

 

With the actual distance across the series of photographs measured, the velocity was 

calculated by using the equation shown at the beginning of this section. 

Figure 28 shows an image created with the series of Sensicam photographs used to 

measure the velocity of a droplet.  Each photograph is exposed for 4 µs, and the droplet is 

traveling from left to right. 
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Figure 28: ImageJ Velocity Measurement 
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To calculate the velocity of the droplets in the Nikon photographs, the far right edge of 

one droplet to the far right edge of a later drop was measured.  Counting the number drops along 

this distance the velocity was calculated with the equation presented at the beginning of this 

section. 

4.3.3  Velocity Results 

The calculated velocities of the droplets in the Sensicam images are given in Table 9.  All 

aspects needed to calculate the velocity are shown. 

 

 

Table 9: Sensicam Photograph Calculated Velocity 

Program Scale (pixels/µm) Distance (x) Photographs (m)
Exposure 

Time (n) 
Velocity 

0.12 918.33 µm 10 4 µs 25.51 m/s 
Matlab 

0.13 847.69 µm 10 4 µs 23.55 m/s 

0.12 952.47 µm 10 4 µs 26.46 m/s 
ImageJ 

0.13 879.20 µm 10 4 µs 24.42 m/s 
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Table 10 displays the velocity calculated for the Nikon photographs under the assumption 

that the droplets are being produced at a rate of eighty-thousand drops per second. 

 

 

Table 10: Nikon Photograph Calculated Velocity 

Program 
Assumed 

Frequency 
Distance Droplets Velocity 

Matlab 80 kHz 1911.93 µm 6 25.49 m/s 

ImageJ 80 kHz 1921.43 µm 6 25.62 m/s 

 

 

4.4  VOLUME 

The following assumptions were used in creating a method to calculate the volume of the 

droplets: 

• The ink drop can be described as an ellipsoid, which is defined in Cartesian 

coordinates as 

x 2

a2 +
y 2

b2 +
z2

c 2 =1 

and has an volume of 

Volume = 4
3
πabc  

where a, b, and c, are the radii in the x, y, and z axes, respectively 
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• The only force on the drop is due to its separation from the fluid stream after the 

surface tension has been overcome, and this force distributes itself equally 

throughout the droplet after a very short time interval 

• The effects of gravity and wind resistance are negligible 

With respect to the photographs, the x-axis was treated as the horizontal axis, the z-axis 

as the vertical axis, and the y-axis as the third dimension into and out of the picture.  Since only 

two of the three axes were measurable in the photographs, a method to estimate the y-axis was 

necessary.  By the second and third assumptions as the radius of the droplet fluctuated along the 

x-axis, the radii along the z-axis and y-axis would change equally, and no other forces existed 

that would make them different from each other.  Therefore, the volume could be calculated by 

measuring the horizontal and vertical radii (a and c, respectively) of the droplet and using: 

Volume = 4
3
πac 2  

For the photographs produced by the Sensicam camera, the extents of the droplet were 

measured.  However, due to the effects of blurring mentioned in section 4.3, this measurement 

was not the true diameter.  This was accounted for by using the velocity measurements from 

Section 4.3 to calculate how far the droplet traveled over the time of the exposure, and 

subtracting this distance from the initial measurement. 

 

actual diameter = (initial measured diameter with blur) – distance traveled during exposure 

 

Even though the velocity was calculated for the pictures produced by the Nikon camera, 

the longer exposure times of these pictures did not make this approach practical.  Volumes for 

the Nikon photographs therefore did not take into account the effects of blurring in the 

photograph. 
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4.4.1  Matlab 

After processing the images, the droplet to be measured was enlarged using the “zoom” 

tool in the figure window.  The horizontal and vertical diameters where then measured as 

described in section 4.1.  These dimensions were then converted to radii and used to calculate the 

volume of the droplet.  

4.4.2  ImageJ 

After the images were processed, and the reference scale was set, the droplet to be 

measured was enlarged by using the “zoom” tool.  The horizontal diameter and the the vertical 

diameter were measured, and the results were read for the results menu. These diameters were 

then halved to find the radii, and these radii were used to calculate the volume of the droplets. 

4.4.3 Volume Results 

A sample of 10 droplets from the Sensicam photographs was used to calculate average 

radii and volumes.  Next, 12 droplets from the two Linx photographs were used to calculate the 

same.  The resultant calculated volumes are given in Table 11.  In this table, the mean and 

standard deviation for each radii and the volume are given.  The columns displaying the mean 

values are highlighted in grey because they may be of more immediate interest. 
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Table 11: Volume Calculations 

Program Photograph Scale 

Mean 

a 

(µm) 

a 

Standard 

Dev. 

Mean 

c 

(µm) 

c 

Standard 

Dev. 

Mean 

Vol. 

(pico 

liters) 

Vol. 

Standard 

Dev. 

Linx 0.14 75.53 19.13 69.19 7.41 1551.78 578.30 

0.12 52.86 9.79 65.40 7.33 982.47 323.29 Matlab 
Sensicam 

0.13 44.87 9.03 60.37 6.76 772.67 254.26 

Linx 0.14 69.35 66.37 66.37 7.05 1292.98 355.01 

0.12 35.86 8.54 58.88 6.53 534.64 189.42 ImageJ 
Sensicam 

0.13 33.11 7.88 54.35 6.02 420.63 149.00 

 

 

4.5  DROP RATE 

Knowing the velocity of the ink droplets and the number of droplets over a specific 

range, the drop production rate can be calculated. 

 

drops
second

=
meters
second

×
drops
meter
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Because velocity was not directly calculated for the Nikon photographs, and drop rate 

was assumed, the drop rate cannot be calculated for these images.  In the Sensicam series used to 

calculate volume, the number of droplets was measured over a distance, and the corresponding 

drop breakup rate was calculated. 

The above procedures were performed to measure the distance over a series of drops.  

These measurements with the velocities calculated in section 4.3 were used to find the drop rates, 

and the results are seen in Table 12. 

 

 

Table 12: Calculated Drop Rates 

Program Scale Velocity Drops Distance Drop Rate 

0.12 25.51 m/s 10 2645.18 96.44 drops/s 
Matlab 

0.13 23.55 m/s 10 2441.71 96.24 drops/s 

0.12 26.46 m/s 10 2658.18 99.54 drops/s 
Sensicam 

0.13 24.42 m/s 10 2453.70 99.52 drops/s 

 

 

4.6  SPACING 

Calculation of spacing was formulated to measure the distance from the center of one 

drop to the center of an adjacent drop.  To calculate the spacing, the distance between the outside 

edges of two adjacent droplets was calculated.  The horizontal diameters of each droplet were 

then measured, and the radii of each were subtracted from edge-to-edge distance.  Blurring, as in 

previous section, could have been considered the Sensicam photographs, but since this would 

have equally shifted the center of each droplet the final results would have been the same. 
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A sample of 12 droplet distances in the Sensicam images, and a sample of 11 droplet 

distances in the Nikon photographs were measured.  The average droplet spacing and standard 

deviations were calculated, and are given in Table 13. 

 

 

Table 13: Spacing Results 

Program Photograph Scale Mean Droplet Spacing (µm) Standard Deviation 

Linx 0.14 316.65 13.66 

0.12 264.19 17.84 Matlab 
Sensicam 

0.13 243.87 16.47 

Linx 0.14 322.09 9.16 

0.12 267.32 9.04 ImageJ 
Sensicam 

0.13 246.75 8.34 
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5.0  DISCUSSION 

5.1  GENERAL PROCEDURES 

In general, the procedures presented are consistent from program to program, and system 

to system.  When comparing the results found using Matlab of a particular photograph to those 

found using ImageJ, the linear measurements made typically differ by less than 10 µm.  This 

corresponds to less than one and a half pixels difference.  The largest difference in linear 

measurement is seen in Table 9, where the measurements over ten droplets differs by at most 35 

µm, which corresponds to four pixels.  Such a difference is slight, and easily contributed to 

human error.  Since the diameter measurements were made by drawing the cursor over the 

extents of the droplets by hand, an inconsistency in picking beginning and end points for the 

droplets could have easily been made.  Differences could also be contributed to any difference in 

the algorithms used by each program.  This is very plausible considering the threshold level for 

edge detection was specified in Matlab but not ImageJ. 

Consistency is also seen when comparing the results of the Linx printer with the custom 

experimental setup.  The measurements for velocity and spacing are very similar between the 

two systems, and linear dimensions differ overall by at most four pixels as well.  Despite running 

each system at the same levels of pressure and voltage, precision could have been compromised 

due to a piece of equipment being out of calibration.  In addition, a difference is naturally 

expected between the two systems because ink was used with the Linx printer, and water was 

used with the custom experimental setup.  Differences between the fluid characteristics such as 

density and viscosity are expected to have an impact on the results, despite how similar they may 

be.  Humidity and temperature at the time of the experiments may have played a role as well.  

Any error in measurement could have then amplified these system dissimilarities. 

 65



5.2  VELOCITY AND DROP RATE 

In chapter four two items draw immediate attention.  First, despite being produced by 

very similar processes, the volumes of the measured droplets in the Linx photographs are much 

larger that those recorded by the Sensicam camera.  Second, the modulator was excited by a 

frequency of 80 kHz, but the calculated drop rate was found to be on the order of 96 - 99 kHz. 

It is immediately observed that for the volume calculations the average vertical radius, c, 

is fairly consistent across all measurements, differing by no more than 15 µm.  However, the 

average horizontal radius, a, of the Linx system is calculated to be much different than that of the 

droplets recorded by the Sensicam camera, at points more than twice the size.  It also makes little 

sense that that the droplet would be so non-spherical, regardless of any transient the droplet may 

be experiencing.  While some difference due to natural differences in the fluids, closer results are 

anticipated due to the similarity of results of other observable factors.  This error in calculation is 

contributed to the adjustment to the horizontal diameter made by calculating the distance 

traveled with the calculated velocity and subtracting that distance from the measured diameter.  

Not applying the same method to the Linx images additionally amplifies any differences when 

trying to draw a comparison.  A better comparison can be made by looking at the radii and 

volumes without accounting for velocity in Table 14. 
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Table 14: Volume Calculations without Taking Into Account Velocity 

Program Photograph Scale 

Mean 

a 

(µm) 

a 

Standard 

Dev. 

Mean 

c 

(µm) 

c 

Standard 

Dev. 

Mean 

Vol. 

(pico 

liters) 

Vol. 

Standard 

Dev. 

Linx 0.14 75.53 19.13 69.19 7.41 1551.78 578.30 

0.12 103.88 9.79 65.40 7.33 1906.78 511.61 Matlab 
Sensicam 

0.13 95.89 9.03 60.37 6.76 1499.74 402.39 

Linx 0.14 69.35 66.37 66.37 7.05 1292.98 355.01 

0.12 88.78 8.54 58.88 6.53 1311.72 338.06 ImageJ 
Sensicam 

0.13 81.95 7.88 54.35 6.02 1031.70 265.90 

 

 

It can be seen that without accounting for velocity, the average volumes are much more 

similar, though a notable difference does still exist.  The issue of the horizontal and vertical 

measurements being very much different from each other still exists as well.  Now instead of the 

horizontal radii being much smaller than the vertical radii, it is now much larger.  By assuming 

the droplets are to be observed as spherical, it can be said that the initial calculations show the 

velocity as being calculated too high.  The volumes and horizontal radii found without 

accounting for velocity then indicate that velocity does in fact need to be considered when 

interpreting the photographs. 

By itself, the calculation of a drop rate on the order of 96 - 99 kHz may raise questions as 

to whether the system is linear.  Many factors may have contributed to an error in the drop rate 

calculation though, many that have already been mentioned in the previous discussion of general 

procedures and volume.  One additional factor may be the velocity, which is proportional to the 
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drop rate.  When calculating velocities in this thesis, the time used to divide the distanced 

traveled was the sum of nine exposure times.  With zero delay in between exposures, no other 

time needed to be accounted for.  Despite the camera being completely electrically controlled 

(that is, no mechanical shutter), the concept of having zero delay is questionable.  If an inherent 

delay exists, the time used in the calculation of velocity is smaller than what it should be, which 

would have led to a velocity that was calculated to be too high than what it actually is, which 

directly creates a calculation of a drop rate that is also higher than what it actually is. 

These observations on volume and drop rate lead to the conclusion that the velocity was 

calculated too high, but for reasons that are uncontrollable with the current methods and 

processes.  Regardless, the velocities that were calculated are very close to the velocity 

estimation made before this thesis was written, which is approximately 21 meters per second. 

5.3  REFERENCE SCALE 

Error in the calculated results could have resulted from any error in the references scales.  

For the Linx photographs, the edges of the LED are not distinct, so as the light from the LED 

gradually fades to complete black, the actual edge of the LED needed to be approximated.  This 

could have very easily led to a miscalculation of reference scale. 

For the Sensicam photographs, using the diameter of the fluid stream has many factors to 

consider.  In the analysis, it was assumed the diameter of this stream was the diameter of the 

orifice.  The diameter of the orifice being a manufactured component is produced within a 

certain level of tolerance, and therefore may not be exactly 60 µm.  In addition, the exact fluid 

dynamics, and their effect on the diameter of the stream as it leaves the orifice is unknown. 

Using the outside diameter of the nozzle has some ambiguity as well.  Although it is 

static, the surface of the nozzle is visible, indicating that the stream is not fully perpendicular to 

the camera despite the best efforts to do so.  With this angle, droplets in one portion of the stream 

may be closer to the camera than in other portions, adding some inaccuracy to the measurements. 
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5.4  LIGHTING 

The LEDs as a light source proved to have a great influence on the quality of the 

photographs.  If too close to the focal point of the camera the different features of the LED could 

be distinguished, and many voids exists, where droplets were not exposed.  Moving the LEDs 

farther away from the focal point reduced the voids, and made the light appear to be more evenly 

distributed.  The LEDs overall had a very granular effect on the image quality, which made the 

detected edges not very distinct in appearance. 

An extreme example of the LEDs positioned too close to the camera’s focal point, 

exposing the voids in between them is seen in Figure 29.  An example of the LEDs being 

positioned farther away from the focal point can be seen in Figure 30.  In this figure, the area in 

the middle where the LED is most intense has excellent contrast despite the noise, but towards 

the fringes of LED, the light intensity is less brilliant, more noise is present, and droplets are 

poorly recognized, making their analysis somewhat questionable.  Figure 30 also shows how 

even at farther distances the circularity of the LEDS creates a circular gradient of light. 

 

 

 

Figure 29: Sensicam Photograph, LEDs Very Close 
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Figure 30: Sensicam Photograph, LEDs Far Away 
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6.0  CONCLUSIONS 

The work presented in this document has created the framework to construct and use a 

system to produce droplets from a CIJ system, to record the droplets photographically, and to 

analyze the images to deduce information about the droplets.  While the resources of many 

people were used to accomplish this, the efforts of myself specifically include: 

• Creating specifications and sourcing of components not currently available 

• Utilization of all available resources to accomplish the desired goal 

• Development of practices that best utilize the experimental systems 

• Selection of software to analyze the photographs 

• Development of techniques to analyze the photographs with the selected software 

• Analysis of results 

Pressure, modulation voltage, and modulation frequency are controllable, and methods to 

evaluate droplet volume, drop spacing, and droplet velocity, and drop production rate were 

successfully developed.  The experimental arrangements described allow one to develop a test 

environment from either limited or extensive resources.  Enough information has been given to 

create such a test environment, to trouble shoot or enhance a current working system, or trouble 

shoot or operate the specific test units described here which are found at the University of 

Pittsburgh.  The inherent error that exists in the test environment resulted in an error of 

approximately 20% from the anticipated values. 
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While some error exists in the measurements and calculations presented, the observations 

presented to argue that the actual velocity is lower than the calculated velocity shows that the 

procedures and methods presented demonstrate a level of accuracy within range of previously 

measured and theoretical values.  Any inaccuracies can be contributed to measurement error, 

environment effects on the fluids, and inherent levels of precision that may be lacking in the 

experimental apparatuses used. 

Many improvements could be added to future evolutions of the described systems.  The 

vises used in the custom system, though sturdy, are by no means precision instruments.  Holding 

devices custom tooled for the purpose of holding and adjusting the positions of the fluid ejection 

system, lighting source, and camera would greatly enhance the accuracy, reliability, and 

precision of the system. 

In addition, a lighting source of greater intensity and planar luminescence will aid greatly 

in the ability to analyze the recorded photographs.  Higher levels of light intensity will allow 

greater contrast at higher exposure speeds, making it easier to analyze droplets at greater 

velocities.  Background image noise will be drastically reduced with lighting that is more evenly 

spread.  Many of the photographs presented in this thesis show the negative effects the curved 

light from the LEDs imposed upon the image backgrounds making processing of them often 

difficult. 

Different methods for defining a reference scale would be of great benefit as well.  The 

methods described here require a feature such as the LED or nozzle to be in view of the 

photograph, which limits the extent that the droplets can be magnified and scaled.  Smaller 

reference objects that can be positioned the same distance as the stream, and in view of the 

camera, will allow greater magnification and greater precisions in measurement. 

Even without these additions, the systems and methods described will prove to be 

adequate in the evaluation of a CIJ system when designing it for either the application of 

printing, or new research endeavors. 
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APPENDIX 

A.1  REFERENCE SCALE 

close all, clear 

 

%Load and display original image 

I = imread('DSCN1928.JPG'); 

figure(1) 

imshow(I) 

title('Original Image') 

 

pixval 
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A.2  PROCESS IMAGES 

%for thesis 

 

close all, clear 

 

%Load and display original image 

I = imread('DSCN1934.JPG'); 

figure(1) 

imshow(I) 

title('Original Image') 

 

%converts RGB to grey, if necessary, be sure to adjust subsequent variables 

I2 = RGB2GRAY(I) 

 

%Display Histogram 

figure(2) 

imhist(I2) 

 

%Perform Histogram Equalization, and display new image 

I3 = histeq(I2); 

figure(3) 

imshow(I3) 
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title('Original Image With Histogram Equalization') 

 

%adjust contrast 

I4 = imadjust(I3, stretchlim(I3), [0 1]); 

figure(4), imshow(I4), title('contrast adjusted') 

 

%Perform Edge Detection 

A=.36; %threshold multiplier 

BW = edge(I4, 'sobel',graythresh(I4)*A); 

figure(5) 

imshow(BW) 

title('Detected Edges') 

 

%using strel and imdilate to dilate the image 

se90 = strel('line', 3, 90);  

se0 = strel('line', 3, 0);    

 

BWsdil = imdilate(BW, [se90 se0]); 

figure(6), imshow(BWsdil), title('dilated gradient mask'); 
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A.3  SCRIPT FOR VELOCITY CALCULATION 

close all, clear 

 

%Load and display original images 

I01 = imread('AAA_0001.BMP'); 

I02 = imread('AAA_0002.BMP'); 

I03 = imread('AAA_0003.BMP'); 

I04 = imread('AAA_0004.BMP'); 

I05 = imread('AAA_0005.BMP'); 

I06 = imread('AAA_0006.BMP'); 

I07 = imread('AAA_0007.BMP'); 

I08 = imread('AAA_0008.BMP'); 

I09 = imread('AAA_0009.BMP'); 

I10 = imread('AAA_0010.BMP'); 

 

%Set Minimum x, y, height and width 

R = [0 400 1280 125] 

 

%crop all images 

C01 = imcrop(I01, R); 

C02 = imcrop(I02, R); 

C03 = imcrop(I03, R); 
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C04 = imcrop(I04, R); 

C05 = imcrop(I05, R); 

C06 = imcrop(I06, R); 

C07 = imcrop(I07, R); 

C08 = imcrop(I08, R); 

C09 = imcrop(I09, R); 

C10 = imcrop(I10, R); 

 

%Define Big Matrix 

l=1; 

VEL(l:l+125,1:1280)=C01; 

l = l+126; 

VEL(l:l+125,1:1280)=C02; 

l = l+126; 

VEL(l:l+125,1:1280)=C03; 

l = l+126; 

VEL(l:l+125,1:1280)=C04; 

l = l+126; 

VEL(l:l+125,1:1280)=C05; 

l = l+126; 

VEL(l:l+125,1:1280)=C06; 

l = l+126; 

VEL(l:l+125,1:1280)=C07; 

l = l+126; 
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VEL(l:l+125,1:1280)=C08; 

l = l+126; 

VEL(l:l+125,1:1280)=C09; 

l = l+126; 

VEL(l:l+125,1:1280)=C10; 

l = l+126; 

VEL(l:l+125,1:1280)=255; 

l = l+126; 

VEL(l:l+125,1:1280)=255; 

 

figure(1), imshow(VEL) 

 

%Perform Histogram Equalization 

VELEQ = histeq(VEL); 

 

%adjust contrast 

VELCON = imadjust(VELEQ, stretchlim(VELEQ), [0 1]); 

%figure(4), imshow(I4), title('contrast adjusted') 

 

%Perform Edge Detection 

%A=.17; %threshold multiplier 

%BW = edge(VELCON, 'sobel',graythresh(VELCON)*A); 

%figure(5) 

%imshow(BW) 

 78



%title('Detected Edges') 

 

%using strel and imdilate to dilate the image 

%se90 = strel('line', 3, 90);  

%se0 = strel('line', 3, 0);    

 

%BWsdil = imdilate(BW, [se90 se0]); 

%figure(6), imshow(BWsdil), title('dilated gradient mask'); 

 

figure(2), imshow(VELCON) 
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